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Question: 1 
Scenario: John, a Citrix administrator, needs to enable the synchronization of PDA devices for 
both local and remote users. Users will connect from the LAN to the Web Interface. Which two 
options allow John to accomplish this? (Choose two) 

 
A. In the Microsoft Management Console, John can add the Device Manager snap-in. 
B. The Presentation Server Console, John can enable the automatic sharing of PDA devices in 

server properties. 
C. In the Presentation Server Console, John can create a policy under properties and enable the 

policy rule "Turn on automatic virtual COM port mapping". 
D. In the Access Suite Console, John can create a MetaFrame Presentation Server site, select 

Manage Client Connection settings and enable the PDA settings. 

Answer: C, D 

Question: 2 
Scenario: You created a policy for the Human Resources group which restricts the users in that 
group from accessing local drives. Human Resources has recently  dded five new recruiters to 
the team who will travel to universities throughout the country to recruit candidates. While on 
these trips the recruiters will need to save data to their laptops and upload information nightly to 
the database which is published and load-balanced across all servers in the farm. You create a 
new policy for the recruiters called "HR recruitment" and disable the rule which restricts the 
access to the client drivers. 

 
Which two filter types should be applied to the "HR recruitment" policy to exclude the recruiters 
from the client drive mapping rule? (Choose two) 

 
A. Server 
B. Location 
C. Client names 
D. Users and user groups 
E. Connections made through controlled access 

Answer: C, D 

Question 3 
Scenario: You created several polices and configured filters for them in the Presentation Server 
Console.  You now wish to verify the enforcement of these polices on specific user accounts in 
your enterprise.  How can you view the effective Citrix policies for these user accounts? 

 
A. Filter the policies by user on the Policy Management Console. 
B. From the client device execute the GPRESULT application. 
C. In the Presentation Server Console, select Tools, Wizards, Effective Policy Wizard. 
D. In the Presentation Server Console, execute the search function focused on the target user 

accounts and click "View Resultant Policy". 

Answer: D 

Question 4 
Scenario: You created a policy for the Human Resources group called "HR standard" which 
restricts the users in that group from accessing local drives. Human Resources has recently 
added five new recruiters to the team who will travel to universities throughout the country to 
recruit candidates. While on these trips the recruiters will need to save data on their laptops and 
upload information nightly to the database which is published on a Presentation Server. You 
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create a new policy for the recruiters called "HR recruitment" and disable the rule which restricts 
the access to the client drivers. 

 
Which two steps are required to ensure that the recruiters are able to access their local drives? 
(Choose two) 

 
A. Rank the "HR recruitment" policy higher than the "HR standard" policy. 
B. Rank the "HR standard" policy higher than the "HR recruitment" policy. 
C. Filter the "HR standard" policy by users, specify the five recruiter accounts and allow access. 
D. Filter the "HR recruitment" policy by users, specify the five recruiter accounts and allow 
access. 

Answer: A, D 

Question 5 
Through which three management tools or utilities can shadowing be enabled for users of 
Presentation Server? (Choose three) 

 
A. Access Suite Console 
B. Presentation Server Console 
C. Presentation Server Installation 
D. Citrix Connection Configuration Utility 
E. Web Interface Administration Console 

Answer: B, C, D 

Question 6 
Scenario: A production company has Presentation Server enabled for local and remote users. All 
users to the "Production" user group. In addition, a remote user group is configured.  Several 
proprietary applications, which are critical to the organization's business, require audio. Remote 
users complain of degraded performance for these applications. The administrator limits the 
audio bandwidth for the remote users through a policy called Remote Audio. An additional policy, 
Production Audio, is configured for the entire Production group, which optimizes the audio for all 
employees in that group. 

 
To ensure that the"Remote Audio" policy is applied to remote user sessions only, which policy 
should be ranked highest? 

 
A. Default user 
B. SpeedScreen 
C. Remote Audio 
D. Production Audio 

Answer: C 

Question: 7 
What is the purpose of the local host cache? 

 
A. It handles queries regarding server load values locally from application. 
B. It ensures that pertinent data is accessible locally even of the data store database is 

unavailable. 
C. It provides data about the local server to the Presentation Server Console over a TCP 

connection. 
D. It stores server load, active session and disconnected session information locally for 

Presentation Server. 
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Answer: B 
 

Question: 8 
Which three types of persistent data are contained in the Presentation Server farm data store? 
(Choose three) 

 
A. License files 
B. User profiles 
C. Printer drivers and mappings 
D. Published application configurations 
E. Presentation Server administrator accounts 

Answer: C, D, E 

Question: 9 
What is contained in the data store database? 

 
A. User profiles for all servers in a given zone. 

B. Dynamic data for all servers in a given zone. 
C. License files for all servers in a given server farm. 
D. Persistent data for all servers in a given server farm. 

Answer: D 

Question: 10 
Which component manages the servers running Presentation by integrating with third-party 
management consoles such as HP OpenView? 

 
A. Load Manager 
B. Network Manager 
C. Resource Manager 
D. Installation Manager 

Answer: B 

Question: 11 
In the Presentation Server Console, what is a requirement for deploying a package using the 
Project Wizard? 

 
A. Project Wizard requires network share point on the file server. 
B. The administrator must have write access to the network share point to deploy a package 

using the Project Wizard. 
C. Only packages 500MB or smaller can be used to deploy a package using Project Wizard to a 

local drive or a network drive. 
D. Project Wizard and Active Directory must be used to deploy the packages to all the servers 

and a network share point is not required. 

Answer: A 

Question: 12 
Scenarios: You created a new ADF package using Installation Manager Packager. You want to 
keep the recorded application on the packager server permanently. 

Within the packager, which action is appropriate? 
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A. From the File menu, save the project. 
B. From the File menu, rollback the project. 
C. From the Tools menu, archive the project. 
D. From the Tools menu, rollback the project. 

Answer: A 

Question : 13 
What is required for a target server to recognize that an Installation Manager package is being 
installed? 

 
A. Packager 
B. Data Collector 
C. Installer Service 
D. Access Suite Console 

Answer: C 

Question : 14 
Which Installation Manager property can an administrator configure from the Presentation Server 
Console? 

 
A. Restarting any server. 
B. Change the default file share. 
C. Change the root build location. 
D. Create Installation Manager reports. 

Answer: B 

Question : 15 
Installation Manager packages can be deployed to and filtered by servers based on__  ___. 

 
A. Sever name 
B. Presentation Server version 
C. Applications previously installed 
D. Windows Server operating system 

Answer: D 

Question : 16 
Before launching the Application Publishing Wizard, which action must be completed to publish a 
package? 

 
A. The target servers must be specified. 
B. The location of the package must be identified. 
C. The package deployment schedule must be set. 
D. The package needs to be added to the Presentation Server Console. 

Answer: D 

Question : 17 
Scenario: An administrator is deploying a package group containing seven packages. Including 
among these are: a hotfix for Application_A (sixth in sequence= and an update to Application_A 
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(second in sequence) The administrator wants to ensure that the hotfix is applied before the 
update. 

 
How can she accomplish this? 

 
A. Specify the order when scheduling the install job. 
B. Right-click the hotfix and then specify the sequence. 
C. Select the hotfix package and click the Move Up button placing it first in the installation 

sequence. 
D. Edit the package group properties to ensure that only the hotfix and the update are listed in the 

assigned packages list. 

Answer: C 

Question : 18 
What happens to the user session when the session reliability timeout expires? 

 
A. The session resets. 
B. The session is logged off. 
C. The session remains active. 
D. The session is disconnected. 

Answer: D 

Question : 19 
Which three steps are required when deploying Clients from Microsoft Active Directory? (Choose 
three) 

 
A. Create a network share. 
B. Configure a policy in Presentation Server for Client deployment. 
C. Create a new package in the Software Installation object for an Active Directory GPO. 
D. Add users to an Organizational Unit designated for the Presentation Server environment. 
E. Browse to the installation files on the network share and assign them to the Organizational Unit 

which includes the client devices. 

Answer: A, C, E 

Question : 20 
Scenario: Your environment includes five servers running Presentation Server. Microsoft Outlook 
and Internet Explorer are published in the farm. 

 
Which SpeedScreen option should be enabled to optimize the image display responsiveness of 
session in which these applications are used? 

 
A. SpeedScreen Flash Acceleration 
B. SpeedScreen Browser Acceleration 
C. SpeedScreen Multimedia Acceleration 
D. SpeedScreen Latency Reduction Manager 

Answer: B 

Question : 21 
During the installation of the Program Neighborhood Agent Client, which information must be 
specified for the Client to function properly? 
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A. The exact name of the server farm. 
B. The URL to the Web Interface logon page. 
C. The IP address or server name of a farm server. 
D. The URL to the Program Neighborhood Agent site server. 

Answer: D 

Question : 22 
Which command line utility can be used to view server load values? 

 
A. QFARM /LOAD 
B. QLOAD /FARM 
C. QLOAD /SERVER 
D. QSERVER /LOAD 

Answer: A 

Question : 23 
Which two rules should be used in conjunction with at least one other rule? (Choose two) 

 
A. Disk I/O 
B. IP Range 
C. Scheduling 
D. Page Faults 
E. Server User Load 

Answer: B, C 

Question : 24 
Which two steps are Citrix recommended practices for creating a custom load evaluator? 
(Choose two) 

 
A. Disable all other custom load evaluators. 
B. Determine baseline performance of the servers. 
C. Set maximum threshold below maximum utilization. 
D. Disable connectivity to the server while creating the evaluator. 

Answer: B, C 

Question : 25 
In which environment would assigned the Advanced Load Evaluator to more appropriate than 
assigning the Default Load Evaluator? 

 
A. In a Presentation Server Advanced Edition environment. 
B. In any Presentation Server environment in which server resources are varied. 
C. In a Presentation Server environment that uses interoperability with MetaFrame 1.8. 
D. In any Presentation Server environment in which the default load evaluator requires 

customization. 

Answer: B 

Question : 26 
Which consideration does an administrator need to keep in mid when configuring printer drivers 
using the auto-replication method instead of the manual replication method? 
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